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This booklet was designed to help both the new and the experienced PcMars for Windows users. The 
Set Up Booklet helps to show new users how to set up their books for the first time. This Beginners 
Booklet will try to get into more detail along with showing you some sample transactions. The 
Advanced Booklet will show detail on “Special” transactions such as sealed grain, crop insurance, 
coop dividends, payroll and budget/cash flow. 
 
This Beginners Booklet will go into detail on different types of check/deposit transactions, transfers, 
recurring transactions, revolving credit, reusing a transaction and information on reconciliation. Like 
most Windows programs and accounting programs, there is always more than one way to do things. 
We hope to show you a standard, simple way to accomplish your record keeping goals by providing 
these examples. We will also refer to the “2.4 Features Booklet” (which we suggest that you print from 
our web page, www.pcmars.com, has screen shots as well as step by step instructions for several 
PcMars transactions). 
 
It is hard to design a booklet that will help those with very limited experience without making the 
“experts” feel like they are being talked down to. Hopefully, everyone will find the information we 
have provided helpful.  For further details on the PcMars program, check the Advanced Booklet 
available on our web site at www.pcmars.com .
 
 
 
 
 

TIP 
Throughout our booklets we use the symbol “⇒” which means “go to”.  So if we say click on Setup⇒Business 
Information, that means to first click on Setup and second click on Business Information. 
 

http://www.pcmars.com/
http://www.pcmars.com/
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Carry Over From Previous Year 
 

When you have used PcMars for a year, you would select the carry over option instead of starting from 
scratch unless you wish to create a totally different set of books. This is what this screen would look 
like:  

 
 
All you need to do from here is to select the set of books used last year for this farm or business. Once 
it is highlighted, the program will automatically put the name and next year of your books to the right. 
You will be asked to confirm the creation of the new set of books. If everything is correct, click on the 
Carry Over button.  You will also note that you have the option to treat your sealed grain as “Income” 
or as a “Loan”. (This only affects sealed grain entered in the “Special Transactions”). 

 
Tack Note 

 

A “Tack Note” has been added to the tool bar. This is designed for the user to be able to add a “note” 
to any transaction. You can do this by either “right clicking” on the transaction and choosing the “Add 
Tack Note Here”, or by “dragging the Note Icon” down to the transaction. 
 

1.  “Right click in” the colored box on each transaction. 
2.  Choose “Add Tack note here” 
3.  The “Add note” window will appear to write your note, then click “OK” to save. 
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To “drag the Note Icon” to the check, just click on the icon , and “drag” the icon into the color part 
of the check. The “Add note” window will appear to write your note, then click “OK” to save. 
 

 
 
To view “Notes” 
 

1. Click on the “Note Icon” in tool bar. 
2. This box pops up (it is a listing of all the notes you have entered). 
3. Highlight the note you want to review. 
4. Click on “Go to note” and the transaction tied to that note will pop up, then you can either 

“Edit” or “Delete” the note. (It is recommended that you delete the note after it is no longer 
needed, so you don’t get a long listing of out of date notes.) 
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Loan Vendors 
 

Adding a Loan Vendor is very similar to adding regular vendors.You follow the same procedure 
outlined for adding a vendor. To enter a “loan vendor”, you click on the arrow next to “type” and then 
select “Loan” from the drop down list  Once “Loan” is selected, you will notice several other choices 
in the screen. Among these, there will be 3 “radio buttons” denoting the type of loan. Choose the 
appropriate option.   
 

• Borrowed (Liability): Select this when YOU BORROW money, and then select an appropriate 
liability code (200s) 

• Loaned out (Asset): Select this when you LOAN money to someone else, and then select an 
appropriate asset code (100s). For example, if you loan money to your children, choose this 
option and assign an appropriate asset code. 

• Loan to employee (Asset): Only available if advanced payroll module is installed. 
• An account code MUST be chosen for each type of loan vendor. For a “borrowed (liability)” 

type loan vendor, a liability code must be used. 
 

If the loan is a “Loaned out (Asset)” type, then an asset account code must be used. Choose either a 
“current” or “non-current” code, depending on when you expect the loan to be paid back (current code 
for payment within the year, and non-current for full payment beyond a one-year period). 

 
 
 

Note  above that each loan vendor has an asterisk and a letter corresponding to the type of loan (*L (for 
liability), *A (for asset) and *C (for CCC). 
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You will notice that the extra line items brought up for loan vendors are the “Term” of the loan, the 
“Beginning of year balance” and the “Interest rate”. The term of the loan will automatically be entered 
according to the account code you selected. The term simply means “how long will it take to pay the 
loan back”. The loan term is noted in the account code description. 
 
The beginning of year balance means exactly what it says – enter the loan balance as of the 
beginning of your accounting year. This will be January 1 if your books are on a calendar year. A 
common mistake that is made here is to put the original loan balance in. If the loan was taken out 
during the year, then the beginning of year balance needs to be zero. The balance of the loan will show 
up when the original loan deposit is made. 
 
The interest rate is where you would insert the rate applied to your loan. (This is not calculated 
anywhere in the program—just for reference purposes). 
 
There is also an “Override Beginning Balance” option. Beginning Year Balance and Beginning 
Cleared Balances are carried over from the previous year and are calculated (read-only) blue values. 
You can, however, override this and enter both the Beginning Year Balance and the Beginning Cleared 
Balance by checking this check box. You should only consider doing this as a last resort. If you choose 
this option, the reconcile feature and check register report will always start from the Beginning Cleared 
Balance value that you manually enter. The reconcile feature cannot reconcile or report on transactions 
from the previous year. 
  

TIP 
A feature on most entry screens you might not be aware of is if you right mouse click on the screen, an 
additional option box will pop up. This can aid in narrowing down a type of vendor if you want to edit 
any of your entries. 
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TIP 
An important thing to remember with the program is that the Loan Vendor “short name” (not the 
Account Code) tracks the loan balance. This confuses some users who think that each loan needs to 
have a separate account code. The key in tracking loans is to make sure that the “Loan Vendor” from 
the Vendor List is used each time a payment or loan draw is made.  You need to make sure that when 
you set your Loan Vendors up that you give them a specific “short name” for the loan to avoid 
confusion as to which vendor to use.   
Also, if you are using the system to write checks, remember it is the long name that prints on the 
checks. 
 
 

CCC Loan Vendors 

Adding CCC vendors is very similar to adding loan vendors. To enter a CCC loan vendor, you click on 
the arrow next to “type” and then highlight the word “CCC”. This will bring up the extra items needed 
for CCC vendors.  An example of what the screen will look like is shown below. 

 

 
 
 
There will be a line for a “CCC Loan No.” which is required to track the tax treatment (election) of 
each loan. This screen will also show whether the CCC Loan should be treated as a “Loan” or as 
“Income”. This was selected in your “Business Setup” screen. You will note that the program will put 
a “C” next to the name on your vendor list to help you verify that it is a vendor to be used for CCC 
transactions. (More information on depositing and paying back CCC loan transactions in the Advanced 
Booklet) 
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Set Up Items “On the Fly” 

 
If you decide that you want to add a vendor, account code, enterprise, description or profit center while 
filling out a check or deposit screen, you simply need to click the Setup Item button after your cursor is 
in the space you wish to “add”. An example of where to find this button is below. 

 

 
 
Once you have clicked on this button, the screen will come up for you to fill in. Once you are done, 
clicking on the Close button will save your changes and take you back to the check/deposit screen.   
 

Entering “Split Checks” 
 

Checks can be written that have to be “split” between two or more expense codes. The example below 
shows how you would do this. 

 
 
You would first enter the total amount of the check along with the vendor, date, etc. on the top half of 
the screen. On the lower part of the screen you would enter the account code number that you want to 
use first and the amount that goes with that account code.  Once you reach the end of that line you need 
to hit the Enter or Tab key. This will drop you down to the next line where you can enter another code 
number and the amount that pertains to that account code.  This continues until you have the entire 
check amount entered and the “Amount Left” number at the bottom of the screen says $0.00. The 
system will not let you save unless the amount left is zero so you can feel safe that every dollar is 
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accounted for. You save the transaction by either clicking on the Save F10 button or pressing the F10 
key on your keyboard. 
 
 
 

Taking Cash Out of a Deposit 
 

The example below shows how you should enter a deposit that has cash taken out of the check amount. 
 

 
 
 

The total amount at the top should show the total “net” amount of the deposit after the money is taken 
out. The first line is showing the check received for hog sales. The amount on that line is the total 
amount of the check received. On the second line is the money that is being taken out of the deposit. 
We used code 964 – Family Living – Non-Deductible/Cash Undetermined. 
 
Notice that there is a “D” in the fourth column. This is done to show that the amount in this row is 
being deducted from the deposit. Whenever you enter an expense code in a deposit screen, the system 
will automatically put the “D” in and assume that you need to subtract the amount in this row to reach 
the net deposit. 
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Using “Multiple Loan & Asset Vendors” as a Right Click  
Option When Entering a Check 

 
This allows the user to pay on several loans with one check (assuming that the payment goes to one 
entity). 
 
1. Right click on the check screen  
2. Choose “Multiple loan vendors” on the drop down (see below) 

 

 
 

Note: it now says “ALL” (Multiple loan vendors) next to the “pay to the order of” box, enter the total 
payment. The screen will change to allow you to select multiple loan Vendors below, (be sure to 
specify the principal and interest paid on each loan).   
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Transferring Money 
 

In this new screen you can easily transfer money from one bank account to another. The running 
balance of both accounts is shown on the right.   
 

 
 
 
 

This transfer can also be easily handled through either the income or the expense screens. Note the 
examples below do the exact same transaction as the “Bank Account Transfer” example above. 
 

 
 

OR 
 

 
 
NOTE:  My preference is to use the “Bank Transfer” screen. 



13

Recurring Transactions 
 
Recurring transactions are any transaction that repeats weekly, monthly, bi-weekly, or custom to the 
same vendor, but not necessarily the same “amount”. It can be anything from an automatic withdrawal 
to a paycheck deposit. To set these up choose Recurring Transactions from the Setup menu. 
The steps for setting up a recurring transaction are explained below. 

 
1. Select “Recurring Transactions” from the “Setup” drop down menu. 
2. Select the “Transaction Type” (check, deposit or credit) 
3. Click on “Add” 
4. A “Recurring Transaction” box will pop up. 
5. Enter the transaction name.
6. Click on the “Recurring period” drop down box and choose the option you want. 
7. Continue filling out the transaction and save it.  
    (see picture below for illustration of steps 1-7 above) 

  

      
 

 
 
After you have entered the recurring transaction, a reminder will pop up on the day specified for the 
transaction. See screen shot below. 
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At specified date for each recurring transaction comes along, this screen will pop up and prompt you to 
“add” the transactions that are scheduled for that day. You have the choice at that time to click “Yes”, 
“No” or “Quit asking”. 
 
1.  If you choose “Yes”, the recurring transaction screen pertaining to that transaction will be displayed 
for you to enter more data such as amount if it is not a specific amount every month. 
 
2.  If you choose “No”, the program will prompt you again in one hour (or the next time you open this 
set of books). 
 
3.  If you choose “Quit asking”, the program will not prompt you to enter this transaction again 
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Revolving Credit 
 
Revolving Credit transactions are usually used to enter any type of credit transactions and can be either 
expense or income. The primary purpose of a “Credit Transaction” is to track transactions paid through 
a revolving credit account such as credit cards or other loan instruments. It is similar to a check except 
that the money is coming from a loan vendor rather than a bank. These transactions will print on the 
reports as a deductible cash expense. 
 

 
 
Credit transactions are normally debit “expense” transactions, but you can change this default setting 
and choose credit “income” transactions. In that case the screen will look more like a regular 
income/deposit transaction and the information will be entered that way. There will be no "Pay to the 
Order of" or Address. Vendors (one or multiple) are entered in the bottom part of the transaction as 
detailed entry information. 
 

TIP 
Remember you MUST use the “Loan Vendor” to track loan balances. 
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Reuse (Linking to Past Year) 
 
The “reuse” button is a time saver to “reuse” information entered in a previous transaction. This button 
will allow you to “reuse” information in a transaction from a “previous year”. The reuse screen has this 
option noted below. 

 
 

When you check “previous year” option, the following screen will appear to allow you to check the 
previous set of books to view the specific transaction information you wish to “reuse”. 

 
 

NOTE:  If you set up these “prior years” under “Setup⇒Business Information⇒Advance (tab)”, you 
WILL NOT be prompted for the prior year set of books. 
 
ALSO — When you “select previous year set of books”, the program automatically saves this to the 
“Setup⇒Business Information⇒Advance (tab)”. So if you (as a consultant) are re-using transactions 
from various sets of books, be aware that the “prior” year link is changing for ALL prior year reports 
like payroll, 1099’s, etc. 
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Hedge Accounts 

Keeping track of hedging gains and losses is another tricky item that the system can help you with. An 
example of a gain in your hedging account is shown below. 
 

 
 
Notice that the Bank Account being used is number 111—Hedge Account. That is because until the 
profit/loss is known, this will be treated just as an account transfer.  When you know the accrued profit 
or loss, you can make the appropriate entry. See the example below. 

 
 
In the example above the profit of $500 was entered as income—code 359 (Hedge Profits).  Since the 
income was reinvested, the 111—Hedge Account was used. When you take the money out of the 
account, that will be done just like a bank transfer. 
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Loan Deficiency Payments 

Entering LDP payments are relatively simple. The biggest thing to remember about them is that in 
most cases they are deposited directly into your account, so there will be no deposit slip to reference.  
An example is shown below. 
 

 
 
One suggestion is to put the number of bushels LDP’s in the unit section to help keep track of how 
many bushels you have turned in. The account code used (355) was set up in the account code section 
and renamed LDP’s. 

Entering Units and Weights in Entries 

It is very important to get into the habit of entering units and weights with all of your entries that call 
for them.  Many of the reports will print out average prices per unit and per weight. Also, when your 
local IFBA Consultant is doing your Analysis, he will need these totals to do it correctly. By utilizing 
the units and weights column, you will forever be able to determine the cost per head and cost per 
pound of your livestock purchases and sales. You will also be able to determine purchase and sale 
prices per bushel on your grains. Commercial feed costs per pound will be figured, seed costs per bag, 
and on and on.  Just because you took a little more time to enter one more level of detail, you will be 
able to gain so much more from your records. 
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Payroll Information 
 

PcMars default payroll system utilizes the federal, state and social security withholdings.  When your 
payroll is properly setup, the entering of payroll checks is a simple procedure.  By clicking on 
Setup⇒Payroll⇒General Information and Setup⇒Payroll⇒Employee List, you can set up all your 
payroll data. This process is discussed in detail in the Advanced Booklet.   
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Editing and Deleting Transactions 

The first step in editing or deleting a transaction is finding the right transaction to work with.  This can 
be done in two different areas, either the Find Transaction (flashlight icon) or the Browse (pair of 
glasses icon).  The find transaction works well when you have one specific entry to find and you know 
most of the information in it.  The browse is a much better way to find something if you aren’t certain 
exactly which transaction you want.  Below is an example of how the browse works.   
 

 
 
The screen in the background is showing the results after the Browse Select screen was filled out. You 
get to the browse select screen by clicking on the Select button in the browse screen. After filling out 
the information you know is in the entry you want in the select window you click on the OK button 
and any transaction that contains that information is listed in the browse window. You can fill out as 
much or as little information you want, however the more information you fill out the narrower your 
search. 
 
To edit any of those transactions, you double click (click twice rapidly) on that entry and it brings up 
that entry in its original screen. You then make the changes you want to make and click on the Save 
F10 button to save the changes. If it is an entry that needs to be deleted, you double click on the entry 
to bring it up in its original screen then click on the word “edit” on the toolbar and select “delete 
transaction” in the drop down window. A window will pop up verifying that you want to delete the 
transaction, and if you answer yes the transaction will be deleted. 



21

Control of Period Overview 

Whenever someone asks me about the period, my explanation is:  “The period number simply 
corresponds to your bank statement”.  They are the transactions listed on your bank statement that 
cleared the bank during this reconcile PERIOD.”  (Period 1 EQUALS the first bank statement you 
receive in your book year.) 
 
Because PcMars users enter their transactions differently, PcMars has enabled users to turn “Direct 
Control of the Period” ON or OFF.  This is a program option under Options⇒Miscellaneous 
Options⇒Direct control of period.  Following is a general explanation of the two options. 
 
NOT Using Direct Control of Period (95% of users) 
 
If you enter any transactions prior to receiving your statements, do not use “Direct control of 
period”.  This is the preferred method for users because they can enter transactions anytime and 
utilize PcMars check and deposit printing capabilities.   
 
This method is the easiest for most users because they simply enter transactions on an ongoing basis 
and then reconcile them when they receive their statements.   
 
The technical explanation is that PcMars will assign a period “0” to each transaction when entered.  
Then when you reconcile to your statements, PcMars will automatically assign the month (period) to 
the cleared transaction. 
 
Using Direct Control of Period (5% of users) 
 
If you are entering ALL your transactions directly from your statements, this method may work for 
you because you know the accounting “period” when they cleared prior to entering them into the 
PcMars.  When you enter the transactions, you must specify the bank statement period.  This method 
is a “carryover” from the past DOS version and should ONLY be used when you enter ALL 
transactions directly from your statements. 
 

TIP 
 
MY PERSONAL PREFERENCE is not to use the direct control of period. Even if you are entering 
transactions from your bank statement, I recommend you enter all transactions; then choose 
Transactions⇒Reconcile to bring up the reconciliation screen; click the first transaction and then 
press/hold down the “X” key. PC Mars will quickly clear every transaction for you and you can easily 
check to make sure you reconcile with your bank statement. 
 

TIP:  Just remember the accounting period should coincide with the bank statement. 
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Assigning Periods 

 
Reconcile Example (Without Direct Control of Period) 
 
 ...........When the “Direct Control of Period” option is turned OFF, you will choose the “Bank 
Statement period to reconcile with”. 

                      
 

 
Reconcile Example (With Direct Control of Period) 
When the “Direct control period” is turned ON, you will choose the “period” (1) to reconcile your 
transactions with. 

                                       

In version 2.4, periods 1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11, 12, are available for January through 
December of the current year (assuming a calendar year). 
 
Additionally, there are twelve more periods for transactions written in the current year’s books that 
clear in the following years books (or “next year”). There are periods “ n1, n2, n3, n4, n5, n6, n7, 
n8, n9, n10, n11, n12” (“n” is for next year’s).  
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Reconciling Your Bank Statement or Revolving Credit Statement 
(Direct Control of Period OFF) 

 
When you receive your bank statement or Revolving Credit statement (credit card or Farm Service), 
either go to Transactions⇒ Reconcile or click the red check mark icon on the tool bar. After you do 
this, you will be asked which month you want to reconcile, choose the appropriate month.  
 

Steps to Reconciliation: 
 

1)  Choose the account you wish to reconcile with using “Select” drop down box. Note that you can 
either choose bank or credit accounts. Once you select “credit account”, you will be prompted to select 
a loan vendor.  
 

2)  Confirm that the “Bank Statement period to reconcile with” is correct (this is the accounting month 
(period) to coincide with your bank or credit statement). 
 

3)  Enter your “Target ending” balance on the right side of the screen. (This will be the ending balance 
on your bank or credit statement.)  PcMars will automatically adjust your cleared balance as you clear 
your transactions. So you can instantly see the amount needed to balance, shown as the “Difference”.  
PcMars also counts the number of transactions cleared and calculates the total dollars for deposits and 
checks, to help you find any discrepancies with your statement. 
 

4)  Simply check the transactions that are listed on your bank statement by clicking with the mouse in 
the “Clr” box or using the “x” key 
 

 

TIP: If you click the first transaction and then press/hold down the “X” key.  PC Mars will quickly 
clear every transaction. 

Note:  If you select “All Entries” to reconcile with, you will not have the option to enter target 
ending balance or to view the Beginning or Ending balances. This is because “All Entries” 
shows every bank account transaction, so it cannot be reconciled to a single statement.  
Choosing “All Entries” is not recommended for this reason. 
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Additional Reconcile Screen Options 
 

1.  Reconcile previous year’s transactions: You can reconcile transactions entered in the previous 
years set of books by checking this box.  [If a link has not been setup to the previous year set of books 
(under Business Information⇒Advanced Tab), you will be asked for the previous year set of books.]  
Then you can reconcile transactions from the previous year. PcMars will default to the “same” month’s 
bank statement, when the previous year is selected. For example, if you have chosen to reconcile the 
January bank statement and then choose “Reconcile previous year’s transaction” the default month will 
be the  “current year”, “January” (or “n1”).   
 

When you are done in the previous year, uncheck the box, and you will go back to the current year, 
with the correct bank balances being carried over to the current year. 
 

 
2.  Split Screen for deposits and expenses: This will separate your inflows and outflows just as some 
bank statements.   
3.  Show out of range cleared transactions: This will show all cleared transactions regardless of 
Accounting Month (period).  This may help you look up a transaction that you have previously cleared. 
4.  Edit: You can edit the particular transaction that is highlighted by clicking the "Edit" button or 
double-clicking on the transaction.  PcMars will bring you to the proper screen for the type of 
transaction it is. 
5.  Print: You can directly go and print the check register.  The period or date range, and other setting 
for the Check Register will match your setting on the reconcile screen. 
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Tips for “Direct Control of Period” Users 
 
A. By default the reconcile screen ONLY shows transactions matching the specified period.  IF 

you change the period number, the transaction DISAPPEARS from your screen because it no 
longer matches your search criteria.  IT IS NOT GONE!! 

 
B. If you can’t find a transaction on the reconcile screen, click “Show out of range 

transactions”. 
 

C. DON’T switch back and forth between turning the “Direct Control of Period” ON AND OFF. 
 

TIP 
In order to see any uncleared transactions, click on “Show out of range transactions”.  This will allow 
you to see all the transactions regardless of the period.  
  

Direct Control of Period Reconciliation 
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Printing the Check Register 
The check register option varies depending on whether the “Direct Control of Period” option is ON or 
OFF. 
 

“Direct Control of Period” is OFF (Recommended) 
 

The check register report option will look like this when the “Bank Statement Period” option is 
selected. 

Note that the “Show cleared” and “Show uncleared” functions are disabled.  This is because the “Bank 
Statement Period” option searches for transactions cleared in the appropriate period--Example. July = 
period 7.  Since only cleared transactions have a period assigned, there is no need to have the “Show 
cleared” or “Show uncleared” options. 

                                                
 

When you select to print your check register by “Date” rather than “Bank Statement Period”, the check 
register report option will look like this. 
 

 

 
In this situation PcMars searches for the actual date the transaction was entered.  Since this search 
completely ignores the “period”, the “Show cleared” and “Show uncleared” options are enabled. 
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“Direct Control of Period” is ON: 

The Check Register Report will look like this and you can choose to search for data by “Period” as 
well as “Month” or “Date”.  Note that the “Show cleared” and “Show uncleared” functions are 
enabled.   



 28 

 
Editing Past Years Data 

 
When you need to “edit” data (more than just reconciling) in your previous years set of books, you just 
need to follow this procedure.  An example of this would be if you needed to adjust a principal 
payment and interest break down.  ALL asset and liability balances are updated. 
 

1. When you have your “current” year set of books open, click on “File” 
 

2. Click on “Go to previous year Set of Books” 
 

 
 
3. This will bring up the following screen.  Highlight the “last year’s set of books”.   Click “OK”.  

This will take you directly to your “previous years” set of books where you can edit, change, 
delete, add transactions to that set of books.  

 
 

 

 
 
 
 
 
 
4. After you have finished making any changes/corrections in the last year’s set of books, you will 

click on “File”.  Highlight the option to “Return to current year Set of Books”. 
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When you choose “Return to current year Set of Books”, you will be asked the following: 
 
1.  You will notice that you have the option to “Print a report listing the changes made”, or to “Preview 
changes made” BEFORE you actually carry them over.  By previewing changes, you will be able to 
see the changes that you made and be able to stop the carry over if you see changes that are not correct.  
By printing a report, the balances will be carried over automatically and you will receive a report 
showing ALL the beginning balances for the assets/liabilities “before” you made any changes in the 
set of books and then the balances “after” you made those changes.  After viewing/printing this report, 
you will again be back in your current year set of books. 
 
2. Check this box if you want any new vendors or inventory items, that have been entered in prior 
year’s data, carried over to the new year.   

 
 
NOTE:  You can also find this same “Carry over balances” screen under the “Utility” feature of 
PcMars. 
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Batch Check Printing 
 

1. Under “Options” in tool bar, click on “Miscellaneous Options” 

2. Put a check mark in the “Enable batch printing” box & click “OK” 

3. Then, under “Transactions” in the tool bar, click on “Batch Check Printing” 

4. The “Batch Check Printing” box will open up.  Select the either the “Checks” or “Credit” dial, 

depending on whether you are printing bank checks (your bank account) or revolving credit checks 

(farm service or credit cards) 

5. You can select the specific vendor in the drop down or leave it “All”  

6.  Enter a check mark by the checks that you want to print 

7. Click on “Print”                                                                          
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If you choose not to print the checks at the time you create them, PcMars will save your selection(s) 
until you decide to print them.  Once the checks that have been “selected” to print have been printed, 
the “Print” box will be cleared.  This screen will look like this.  You can also edit a check through this 
screen by highlighting the line and clicking on the “Edit” button at the bottom of the screen. 
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Options 
Located on the “tool bar” are additional Options for PcMars.  There are three options you can turn on 
or off by checking the box—“Show Icon bar”, “Show Hints” and “Sound Effects”. 

 

You also have the option to “Customize the Icon bar”.  Any of these “icons” can be dragged to your 
icon bar so you have access to those icons you use most frequently.  You can also remove icons and 
deposit them to this area. 
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Also listed are “Miscellaneous Options”.  Below is a listing of what these options are and our 
recommendation for using these options. 
 

    
 

»  Show Account numbers on YTD reports, RECOMMENDED 
If selected, the numerical account numbers will appear as well as the account code 
descriptions on the following YTD Reports: YTD Summary Report, Cash Income 
Statement, Multiple Enterprise Report, YTD Cash Flow Format Report, Year End Cash 
Summary Report, and YTD Compare to Annual Budget. 

 

»  Column listing order on YTD reports, YOUR PREFERENCE 
Select the listing order for the four columns of the YTD Summary report between: 
Month / Year To Date / Month Budget / YTD Budget and Month / Month Budget / Year 
To Date / YTD Budget. 

 

»  Automatic backup to hard disk, RECOMMENDED 
This is not a substitute for backing up to an external source—memory stick, flash 
drive or cd.  It is rather a simple way to backup your data, in case of a file error.  
Remember most people lose their data when their hard drive crashes, and this will not 
help in that situation.  
 

»  Default backup is the location last used, RECOMMENDED 
When this is checked, the default backup location will be the last backup location used 
for this set of books.  If a "last" backup location for this set of books is not found, then 
the default backup location is the last backup location used for any set of books.  If this 
box is not checked, the default backup location is drive A. 
 

»  Advanced file management, YOUR PREFERENCE 
This will allow you to directly control path names, drives and sub-directories where 
data is located. 
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»  Enhanced Open/View Set of Books, RECOMMENDED 
1. This new screen lists details about each set of books, such as; Year, Business Name, 

Version,    If it is Cash or Accrual, if it is a Plus set of books, if Advanced Payroll is 
turned on for that set of books, and the Last Date it was Modified. 

2. An additional option under “Year” is to show All the years for each set of books, or 
you can select a specific year.  (for a more detailed explanation, see the 2.4 Features 
Booklet at www.pcmars.com 

 
To Enable This Option: 
 

1.  Click on “options” in the tool bar 
2 . Click on “Miscellaneous Options” 
3.  Check the “Enhanced Open/View Set of Books” box 
5.  Click on “OK”   

 
•  When searching for a set of books in a different directory:  You enable both the 
“advanced file management” & the “enhanced Open/View Set of Books” under Miscellaneous 
Options. Then “click” on “Directory” and browse for the directory that you want, click on the 
new directory & then click “ok”.  This will open up the “new” directory and you can choose the 
set of books that you want to open. 
      

»  Direct control of period, NOT RECOMMENDED 
Because users have different closing bank statement dates and outstanding 
checks/deposits each month, PcMars uses the accounting period (period) to track 
cleared transactions. You can either choose to control the period yourself or let PcMars 
assign the accounting periods for you based on the transaction date. 

 
This option lets you specify what accounting period (bank statement) your entries 
cleared your bank when you enter them.  Because of normal outstanding 
checks/deposits, I would ONLY suggest using direct control of period if you enter 
ALL transactions from your bank statement.   
 

»  Vendor list show matching text option, YOUR PREFERENCE   

When enabled, PcMars will attempt to fill in your vender after you have typed one or 
two characters. 
 

»  Description list show matching text option, YOUR PREFERENCE 
When enabled, PcMars will attempt to fill in your description after you have typed one 

 or two characters. 
 

»  Show cleared balance on checks and deposits, NOT RECOMMENDED  
      When checked, the bank account balance that is shown on the check and deposit entry 
 Window will be the CLEARED bank balance (those transactions that have cleared the 

bank.  When this is unchecked, the regular bank balance (all transactions) will be shown 
             

»  Default description to memo line, YOUR PREFERENCE 
If this is checked, PcMars will print your description on the memo line when printing 
checks.   

 

 
 
 
 

http://www.pcmars.com/


35

» Enable batch printing, (For use with “batch” check printing only)
If this box is marked, a question appears on each check or revolving credit transaction 
screen as to whether you want this check marked to batch later.  If you have it unmarked, 
then you won’t see this question icon all the time.  If you don’t print your checks or you 
always print them at the time of data entry, then this will simplify your life. 
 

»  Show month dialog box before reconciling, RECOMMENDED 
If this box is marked and you do not use direct control of period, then a special dialog box 
appears just before you get to the “reconcile” screen.  This helps you to be sure that you are 
reconciling the right month.  If it is not marked, you go directly to the reconcile screen, but 
pay attention to the month (bank statement period). 

 

»  Show 1st deposit vendor on check register, YOUR PREFERENCE 
Instead of showing the bank account on the deposits when doing the check register, this 
tells PC Mars to print the first vendor of entry items.  If the deposit has only one, then it 
shows that one.  If there are checks from more than one business, then it will print an 
asterisk (*) after the vendor name to tell you that there ARE others.  In many cases, this will 
help you identify just what the deposit is all about. 

TIP:  You can always choose “detail” when printing your bank statement if you want to see all 
deposit vendors. 
 

 
»  Show payroll codes in regular checks, NOT RECOMMENDED 

PcMars suppresses the use of Payroll (gross or net pay) account codes in the pick list if you 
are doing a regular (non-payroll) check.  If you need to show other line-items that add to net 
or gross payroll that are not actually paychecks, then you can mark this spot to enable you 
to do it. 

 
»  Show chart of accounts on report header, RECOMMENDED 

This shows which type of account codes you have selected to use for your accounting and       
will be printed at the top of your PcMars reports. 

 
»  Credit description line on detail reports, YOUR PREFERENCE 

This gives the user some flexible options for display of the credit description in detail 
reports. This is regarding the display of the top level description that is normally the credit 
"Memo" item. You have the options of displaying the first line item description (lower part 
of the credit screen), the top level vendor (the "Pay to"), or the default Memo. 
 

»  Show 1st credit/deposit vendor on reconcile, RECOMMENDED
When this option is checked, the reconcile screen will show the 1st vendor in the 
transaction, which will make reconciling easier. 
 

 »  Enable other advanced backup methods, NOT RECOMMENDED 
This will allow you to back up to other methods for advanced users. We recommend          

       backing up using the Zip File back up to a flash stick/memory stick. 
 
 
 »  Show Set of Books type on Enh. Open/View, YOUR PREFERENCE         

This will allow you to see the type of book that was selected when created.
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Backing Up Your Data 
 

Whenever you finish a PcMars session and choose to “Exit PcMars”, the program asks if you want to 
back up your data.  We always strongly recommend you back up your data.  Once you answer “yes”, 
this screen will pop up. 
 

 
  

 
All you have to do is highlight which set of books you want to have backed up (usually the one you 
were recently working in will already be highlighted) and make sure that you are backing up to the 
right drive. Below is an explanation for each back up option.  Our recommended option is to use the 
“Compressed (Zip) file” and backup to a “Memory Stick/Flash Drive”. You need to highlight the 
book(s) you would like to back up, then click on the “Zip Backup” button. You can also select all 
the books with the “Select All” button. Then proceed to hit “Zip Backup” .  
 
Compressed (Zip) File:  This option is the recommended option for safely backing up your data, and 
we suggest using a “Memory Stick/Flash Drive”. This option allows you to “compress” your set of 
books and email them to your consultant/fieldman. This eliminates the problems with disks, drives and 
CD’s not being compatible from one computer to the other.  Your consultant/fieldman can then restore 
them to his computer, make changes/edit and then email those books back to you within minutes. This 
is the recommended backup! If you need other backup options, you will need to enable “other 
advanced backup methods” under Options ⇒Miscellaneous Options. 
 
Backup for the consultant:  This will allow you to make a backup copy that your consultant could 
access without restoring the data on his computer.  This will also allow you to store more than one set 
of books on larger media storage such as Zip’s or CD’s, because it saves the data under the exact same 
path as on your hard drive.  The disadvantage to using this method is you need to understand data paths 
in order to restore your data. 
 
Other backup location:  This has the same advantage as “Backup for consultant” except you must 
choose or create your own path and directory.  This option allows the most flexibility to save your 
data.  However, it also requires the most computer skills!  ONLY USE THIS METHOD IF YOU 
ARE COMPLETELY COMFORTABLE WITH THE STRUCTURE OF DIRECTORIES. 
 
Drive A (A:\):  This method will save your data to the floppy A:\ drive.  Most new computers do not 
have a floppy drive “A”.  IF you do have a floppy drive, make sure you only use these disks for 
PcMars backup.  Do not save any other data on these disks. 
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Backing up your data under File ⇒Backup Set of Books: 
 

1) You can either select all the books by using “Select All”, or manually highlight the sets of 
books that you want to back up.  To select consecutive sets books from the listing, click on the 
1st set of books, hold down the shift key and click on the last set of books that you want to 
backup.  To select books not located next to each other in the drop down (see above example), 
hold down the control key and left click the books you want.  

2) Then click on “Zip Backup”. 
3)  The “Browse Directory” will open up.  Choose your back up location (we recommend a Flash   

Drive Directory). 

 

 
 

 
 

You need to select the Drive letter assigned to that flash stick. In this example, it is in Drive (H). Click 
on the drive letter assigned to your flash stick and hit OK at the bottom.  
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Restoring Your Data 
 

If your books are ever corrupted on your hard drive or your hard drive crashes, you will need to use the 
“Restore” command to take the back up files and transfer them to the hard drive.  
 
To Restore a Single Set of Books 
 

To do this, select File⇒Restore set of Books from Backup⇒Restore data from zip file, then “Select 
file name & location”. Then choose the drive where your flash drive/memory stick is located. The 
“Will be Restored To” on the right-hand side will automatically fill it in correctly.  
 

Once you are sure this is what you want to restore, click the OK button and restoration of your data 
will begin.  Remember—if you have replaced a hard drive, you must set up the new data path exactly 
as the path was stored on the backup disk. 
 
 

                                
 
Test Backup Option 
 
The Test Backup Option will reinstall your backup data so you can verify the data is saved.  The 
program will automatically create a new set of books with a default name of “Test Back” and copy 
your backup data into this directory.  You will then need to open the “Test Back” books to verify your 
backup data is correct.  Regardless of which backup method you choose, the default directory will be 
“Test Back”.  This option again checks “errors” in backing up to a disc or CD in order to be sure you 
have a “good” backup of your data. 
 
 
To Restore Multiple Set of Books 
 
To do this, select File⇒Restore multiple sets of books (PcMars Zip files), then  
 
1.  Select “From Directory”  
2.  Choose the drive where your flash drive/memory stick is located 
3.  Click “OK” 
4.  Hold down the CTRL key to highlight the books you want to restore OR click on “Select All” 
5.  Click on “Restore” to restore all the books into your PcMars. 
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Internet Accessibility 

 

PcMars has a “Globe” icon on the tool bar which will allow you to easily access the Internet to check 
for any free “patches” that have been posted. 
 

 
 

 
 

Clicking on the “Globe” will bring up the following screen: 
 

                                     
 
 

This screen will tell you the exact version number of your PcMars and show two hyperlinks to access 
the Internet to the PcMars web site and also the web site for SoftShell Computer Service.  You can also 
access this screen by clicking on “Help” above the icon bar. 

 

 
 

PcMars Warning 
 

If a set of books is restored to your computer and opened using a PcMars program that is “Older” than 
the PcMars program used to backup the books, the following warning and screen will appear. 
 

 

  
 

NOTE:  If you have PcMars loaded on several computers, be sure all your PcMars versions are 
the same! 
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Conclusion 
We hope that this booklet was informative enough for you to gain some new insights on how to do 
some of the more difficult entries.  Keep in mind that when it comes to Windows programs, there is 
always more than one way to get the job done.  We have tried to help standardize some of these 
techniques to make it easier for everyone.  Please don’t hesitate to take advantage of our technical 
support areas if you find that you need extra help.  Here are the technical support areas available. 
 

Software Support 
 

Iowa Farm Business Accounting, Inc. will offer support to users who are utilizing the most current 
version of PcMars.  There are three options where you can receive support information: 
 

1. Internet Support — is available at iowafarmbusiness.org or pcmars.com. 
2. E-mail Support — is available at info@iowafarmbusiness.org.   
3. Phone Support — is available at 515-233-5802 (IFBA state office). 

 

The e-mail or phone support will connect you with the Iowa Farm Business Association state office.  
This will guarantee you an answer to your questions from an employee that has experience with the 
program.  
 

Our PcMars Support Policy can be viewed at 
http://www.iowafarmbusiness.org/PcMars/PcMars%20Support%20Policy.pdf 

 

Closing Tips:   
 
Right Mouse Click If you “right” mouse click on a screen, it will bring up many short cut keys plus several 

other options to choose from depending on which screen you are in at the time.  TRY 
IT! 

 

“X” key To clear check/deposit and move to next line or hold down the “X” key to clear ALL 
checks/deposits on the reconcile screen 

 

Ctrl “A” To fill in “amount” box for check/deposit on the data entry screen OR click on “Amount Left” 
to fill out balance of check/deposit. 

 

“F5” key To bring up the calculator.  When you click the green  on the calculator, it will 
automatically paste your results to a numeric field. 

 

“F1” key When you have any PcMars screen open, it will bring up information about the screen you are 
in.  This information is also found by clicking on the word “Help” above your icons or if you 
click on the  button on your icon bar.  (This currently does not work in Vista) 

 

ALSO — Use the “Tack Note”  or the “Notepad”  to remind you of questions you might have 
regarding certain transactions or any other additional detailed information you want to 
keep about your farming records. 

http://www.iowafarmbusiness.org/PcMars/PcMars%20Support%20Policy.pdf

	To do this, select File(Restore multiple sets of books (PcMars Zip files), then



